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Introduction
The purpose of this document is to provide the information and instructions 

required to install the pluginX components necessary for:

 Viewing a PluginX or EChart Rich Client Chart

 Viewing an OrgPlan chart



Aquire’s Customer Care Center provides more information regarding the pluginX 

Viewing OrgPublisher Web Administration

downloads: http://www.aquire.com/customers/support/pluginX

Role Requirements for PluginX Installation
Users must be an administrator on the workstation to successfully 

install the OrgPublisher pluginX viewers. When implementing the pluginX 

for non-administrators, refer to the Alternate Methods for PluginX 

Installation section of this implementation guide.

User Workstation Requirements

Viewing OrgPublisher PluginX / EChart Rich Client Charts

 Pentium® PC compatible or greater 
®







Windows XP, Windows® Vista™, or Windows 7 operating system 

512 MB of RAM 

60 MB available hard disk space 

Microsoft® Internet Explorer 7 browser and later 

Viewing Web Administration and OrgPlan Charts

 Pentium® PC compatible or greater 
® ®







Windows XP, Windows Vista™, or Windows 7 operating system 

512 MB of RAM 

60 MB available hard disk space 

 Microsoft® Internet Explorer 7 browser and later 

 Adequate storage space for charts

http://www.aquire.com/customers/support/pluginX
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About OrgPublisher PluginX 
Implementation

Types of PluginX Viewers
OrgPublisher’s PluginX charts, EChart Rich Client charts, and OrgPublisher Web 

Administration use Microsoft’s ActiveX technology to display the org chart in an 

Internet Explorer browser. The three different pluginX components are described 

below:

1. OrgPubx.ocx: 





Standard end user pluginX viewer

Allows end users to view org charts interactively.

2. OrgPlan32.ocx:





Required for users viewing planning charts. 

Allows planners to make changes to data in published charts that may 

be copied to the Planner's workstation. 

3. OrgPub32.ocx: 

 Required for chart administrators accessing OrgPublisher Web 

Administration

 Allows chart administrators to create and publish charts with Web 

Administration.
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Installation of the PluginX
When a user clicks on a published chart link, opens a planning chart, or launches

OrgPublisher Web Administration for the first time, by default, the user will 

automatically be prompted to install the applicable OrgPublisher pluginX viewer 

from the Aquire web site.   

Each pluginX component (orgpubx.ocx, orgplan32.ocx, or orgpub32.ocx) is 

packaged into a signed CABINET file, also referred to as a CAB file. To 

successfully install the pluginX viewers, you must be an administrator on the

workstation.  

When clicking on the htm link, the prompt below displays. Click Install.

Figure 1. PluginX Installation Prompt 

Click Install when the prompt, Do you want to install this software, displays.

Figure 2. Install the PluginX Component
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If the installation is successful, the page displays.

Figure 3. Page Displays in Internet Explorer

Note: If you are unable to display the page, this indicates you are not an 

administrator on the workstation or IT group policy restricts the download of 

ActiveX content, and you will need the assistance of the IT department to 

implement the pluginX component.

A successful pluginX installation includes:

1. Installation of the OCX (pluginX) file in the following directory:

 32 bit machines: C:\Windows\System32

 64 bit machines: C:\Windows\SysWOW64  

2. Registration of the OCX (pluginX) file in the computer’s registry.

 The PluginX needs to be registered in order for a chart to load. 

 When an ActiveX control is registered for the first time, certain keys are 

written in the registry within HKEY_CLASSES_ROOT. 

This level of permissions is too broad for many organizations.  Note:

Organizations wishing to “lock down” the desktop, and thus control what is 

installed on a workstation, will prevent the ActiveX control from registering. To 

use other methods to distribute the pluginX, please refer to the Alternate 

Methods for PluginX Installation section.

Aquire’s Customer Care Center has an OrgPublisher Client Suite download that 

contains all 3 pluginX files: http://www.aquire.com/customers/support/pluginX

http://www.aquire.com/customers/support/pluginX
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Aquire’s PluginX Certificate

Aquire’s pluginX downloads have a digital signature in order to verify:

 Aquire is the software publisher of the pluginX file



To check the certificate associated with the pluginX component when 

The pluginX cabinet file has not been altered following its publication

downloading the cabinet file: 

1. Click on Aquire in the Publisher field.  

2. The Digital Signature Details window opens. Then, click View Certificate.

Figure 4. View Aquire’s PluginX Certificate

To address questions regarding Aquire’s pluginX certificates, please contact 

support@aquire.com. 

mailto:support@aquire.com
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PluginX Versions

The pluginX component should mirror the version of the OrgPublisher application 

being used to publish charts. 

Each time you upgrade the 

OrgPublisher application, the 

matching version of the pluginX 

component will need to be installed 

on end users’ workstations.

To check the full version of the 

OrgPublisher application, go to Help 

-> About OrgPublisher.  

Figure 5. About OrgPublisher

It is recommended that chart administrators enable the Large About box button 

in the publishing definition (shown below).  This button allows users to check the 

version of the pluginX viewer installed on the workstation.  This information can 

be valuable if troubleshooting is required within a published chart file.

Figure 6. Large About Box Button

Viewing a chart with a pluginX viewer that does not match the version used for 

publishing is not recommended.   This can cause unexpected performance issues 

due to differences in version functionality and should be avoided.
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Publishing PluginX Charts 
When a chart is published using the PluginX option, the following files are 
produced:

PluginX Published Chart Files

File Type Description

.JS File  Contains a code base statement with the version of the 
pluginX file needed to view the chart file.

 Example of the code base statement:
Version 10
('codebase="http://www.aquire.com/codebase10/OrgPubX.c
ab#Version=10,0,2800,1"');
Version 10.1
('codebase="http://www.aquire.com/codebase101/OrgPubX.
cab#Version=10,1,3027,1"');

.OCP File  This is a static file that takes a “snapshot” of the chart at the 
time of publishing.

.HTM File  The HTM file checks for several factors, including:




Internet Explorer browser requirement
It calls the JS file, checks the codebase statement, and 
process the following logic:

 If the PluginX is not registered, a new CAB file is 
downloaded using the codebase URL.

 If the PluginX is registered, then the codebase function 
compares the version number that is registered with the 
version number in the codebase statement. 

 If the codebase statement version number is greater 
than the registered PluginX, then a new CAB file is 
downloaded using the codebase URL.

 If the codebase statement is the same or less than the 
registered PluginX, then the chart is loaded using the 
existing, registered PluginX.
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PluginX Publishing & Architecture 

PluginX provides end users with a rich interactive experience, allowing them 

to navigate and search the chart, create their own groups, access hotspot 

links, and provide accessibility to the visually impaired. 

PluginX provides chart level Password Security and is a publishing option 

when organizations charting less than 5,000 records.

Figure 7. PluginX Architecture
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Publishing EChart Rich Client Charts
When a chart is published using the EChart Rich publishing option, the following 
files are produced:

EChart Rich Client Published Chart Files

File Type Description

.JS File  Contains a code base statement with the version of the 
pluginX file needed to view the chart file.

 Example of the code base statement:
Version 10
('codebase="http://www.aquire.com/codebase10/OrgPubX.c
ab#Version=10,0,2800,1"');
Version 10.1
('codebase="http://www.aquire.com/codebase101/OrgPubX.
cab#Version=10,1,3027,1"');

.OCP File  This is a static file that takes a “snapshot” of the chart at the 
time of publishing.

.HTM File  The HTM file checks for several factors, including:




Internet Explorer browser requirement
It calls the JS file, checks the codebase statement, and 
process the following logic:

 If the PluginX is not registered, a new CAB file is 
downloaded using the codebase URL.

 If the PluginX is registered, then the codebase function 
compares the version number that is registered with the 
version number in the codebase statement. 

 If the codebase statement version number is greater 
than the registered PluginX, then a new CAB file is 
downloaded using the codebase URL.

 If the codebase statement is the same or less than the 
registered PluginX, then the chart is loaded using the 
existing, registered PluginX.

.DLL File  The DLL file is the executable file that enables enhanced 
performance and security for the chart 

.OCS File  The OCS file contains chart data.

.BAT File  The BAT file is the file that is scheduled to run automated 
publishing jobs.
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EChart Rich Client Publishing & Architecture 

EChart Rich Client is recommended for large charts with more than 5,000 

records or when using OrgPublisher advanced security options. It provides 

fast performance for medium to very large charts and provides field level 

security and Microsoft® Active Directory authentication. 

It is intended for end power users and end standard users.

Figure 8. EChart Rich Client Architecture
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Alternate Methods for PluginX 
Installation 
The pluginX is set up to automatically download from Aquire’s web site when a 

user clicks on the .htm chart link. However, when users are not administrators 

on the workstation or when IT security policy restricts downloads of the pluginX 

files, alternate methods to distribute the pluginX are available including:

1. Distributing the pluginX automatically using the same tools used for 

distributing Windows updates. 

2. Placing the pluginX cabinet file on the local intranet site and modifying the 

JavaScript or JS file to download from an internal URL rather than the default 

Aquire site.

3. Aquire also has MSI scripts to help with pushing out the pluginX to end users 

that are available upon request.
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Distributing the PluginX Automatically with
Internal Tools

The IT department can distribute the pluginX automatically using the same tools 

used for distributing Windows updates with the directions below:

This information is intended for the experienced Script developer. Please contact 

your Web Administrator if you need assistance. 

1. The administrator must login and open an org chart within an Internet 

Explorer 7 browser or later. 

2. If prompted, allow the CAB file to download and install the PluginX. Once 

loaded, it stays loaded for all users of that computer.

3. Run an automated process that “pushes” (copies) the PluginX file 

OrgPubX.ocx, OrgPlan32.ocx, or OrgPub32.ocx)(

(C:\Windows\System32 for 32 bit machines or C:\Windows\SysWOW64  on 

to the user’s computer 

64 bit machines)

4. Manually register the pluginX file: 

Run cmd.exe to open the command prompt:

 For 32 bit machines:

Enter: cd C:\Windows\System32  

Then enter: Regsvr32 OrgPubX.ocx

 For 64 bit machines:

Enter: cd C:\Windows\SysWOW64  

Then enter: Regsvr32 OrgPubX.ocx

Note: Regsvr32 OrgPubX.ocx will need to be modified to Regsvr32 

OrgPlan32.ocx when registering the planning pluginX or Regsvr32 

OrgPub32.ocx when registering the web administration pluginX.

. Registration SuccessfulFigure 9
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Redirect Users to Download from an Intranet
Location
When installing the pluginX component, by default, users are directed to the 

Aquire Web Site to download the CAB file. However, if preferred, you can 

redirect users accessing a published chart to download the pluginX cabinet file 

from an intranet location.

This information is intended for the experienced Script developer. Please contact 

your Web Administrator if you need assistance. 

1. An Administrator must download the OrgPublisher PluginX Cabinet (CAB) file

from the Aquire web site. Pick the version that applies.
Version 10 CAB File:
http://www.aquire.com/codebase10/OrgPubX.cab#Version=10,0,2800,1

Version 10.1 CAB File:
http://www.aquire.com/codebase101/OrgPubX.cab#Version=10,1,3042,1

2. Copy the cabinet file to your Intranet web server.

3. Publish the OrgPublisher organizational chart if this has not already been 

done. 

4. Navigate to the folder containing the published 

chart files.

5.

6.

Right click on the JavaScript or JS file

Select Edit.

7. The JavaScript (JS) file displays:

Figure 11. Example JavaScript File Codebased Statement

Figure 10. Edit JS File

http://www.aquire.com/codebase10/OrgPubX.cab#Version=10,0,2800,1
http://www.aquire.com/codebase101/OrgPubX.cab#Version=10,1,3042,1
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8. The codebase statement in the published JS file must be modified to point to 

the internal location you deploy it to:

CODEBASED STATEMENT - BEFORE

document.write

http://www.aquire.com/codebase101/OrgPubX.cab#Version=10,1,3042,1('= ");

CODEBASED STATEMENT – AFTER

document.write

http://www.mynetwork.com/codebase101/OrgPubX.cab#Version=10,1,3042,1('= ");

Figure 12. Modified JavaScript File

9. Each time you publish PluginX or EChart Rich Client chart, the JavaScript (JS) 

file is overwritten.  To preserve the changes made to the JavaScript (JS) file, 

open the chart file in OrgPublisher.

10.Go to the File Menu and 

select Publish.

11.The Publish Charts window 

opens.  Select the publishing 

definition in the list. 

12.Click Update.

Figure 13. Update Publishing Definition

http://www.aquire.com/codebase101/OrgPubX.cab#Version=10,1,3042,1
http://www.mynetwork.com/codebase101/OrgPubX.cab#Version=10,1,3042,1
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13.Click Next 2 times and the 

Publish to Location screen 

displays. By default, the

Overwrite existing HTML and 

JS files box is checked.

Clear the Overwrite existing 

HTML and JS file option. 

Note: You can clear the check 

box during creation of a new 

publishing definition or when 

updating an existing 

publishing definition. 

Figure 14. Uncheck Overwrite JS File

14.Click through and publish the chart to update the publishing definition.

15.Save the chart file to save the updates made to the publishing definition. The 

JavaScript file modification will now be preserved each time the chart is 

republished.
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Request Aquire MSI Scripts

Aquire has MSI scripts (Microsoft Installer packages) available to assist with 

pushing out the PluginX files to locked down workstations. The MSI scripts will 

install and register the pluginX component on the workstation.  

If you require the MSI scripts to automate the installation of the PluginX, please 

send an email to support@aquire.com to request these files.  Include the full 

version number of the OrgPublisher application installed to ensure you receive 

the set of correct instructions.

To verify which version of 

OrgPublisher is installed, open the 

application and go to Help -> 

About OrgPublisher.  The full 

version number will display.  

Figure 15. About OrgPublisher

Note: Aquire does not provide technical assistance or support for the MSI scripts.      

mailto:support@aquire.com
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Testing the PluginX Installation
To test if the pluginX file successfully installed on a workstation, click on a chart 

link to open it in the browser.  If needed, click on the Aquire sample chart link:

OrgPublisher 10.1 Chart Sample: Communications.

If the chart displays, the installation was successful.

Note: It is recommended to add the published chart URL to the list of Trusted 

Sites in Internet Explorer.  

Troubleshooting 

If a red X displays in top left-hand corner of the Internet Explorer browser, this 

means an administrator will need to assist with installation of the pluginX on the 

workstation.  

Figure 16. Red X in Internet Explorer

If you are prompted to install a pluginX file each time you view a chart, then an 

administrator will need to assist with installing the pluginX viewer as you may 

not have permissions to write to the registry.

Figure 17. Install PluginX

http://www2.aquire.com/products/orgpublisher/samples/charts_OP10/Communications.htm
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If you are prompted with the following message, you will need to allow the add 

on to run in the website.  If the chart does not display after you indicate to allow 

the add-on, this indicates a group policy may prevent users from running ActiveX 

content.  The IT department will need to be contacted to determine if the pluginX 

can be run.

Figure 18. Run PluginX
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PluginX End User Help
The pluginX toolbars used in published PluginX/EChart Rich Client charts, 

OrgPlan charts, and OrgPublisher Web Administration provide end user help so 

that users can become more familiar with OrgPublisher toolbar functionality.

PluginX/EChart Rich Client End User Help
The end user help in a PluginX/Echart Rich Client chart is available by clicking on 

the button in the toolbar.  

When selected the user will be directed, by default to the Aquire web site to 

access End User Help at the following link:

http://pluginx.aquire.com/support/op101pluginxhelp/make_chart_work.html

If preferred, you can choose to redirect users to an intranet URL to access a 

tailored end user help file.  To do this, follow the directions below:

1. Copy your tailored PluginX help file to 

your Intranet Web Server.

2.

3.

Open the chart file in OrgPublisher.

Go to the File Menu and select Publish.

Select the publishing definition in the list4.

and select update.

5. In the following page of the publishing 

definition, type the intranet URL of the 

pluginX help file in the field below:  If 

applicable, enter a URL for a PluginX 

help file.

6. Publish the chart to update the 

publishing definition.

7. Save the chart to also save the updates 

to the publishing definition

Note: You can enter the URL for the 

PluginX help during creation of a new 

publishing definition or when updating 

an existing publishing definition.

Figure 19. OrgPublisher End User Help

Figure 21. OrgPublisher PluginX toolbar

Update Publishing DefinitionFigure 20. 

http://pluginx.aquire.com/support/op101pluginxhelp/make_chart_work.html
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OrgPlan End User Help
The end user help in an OrgPlan (planning chart) is available by clicking on the 

button in the toolbar. 

When this button is selected, a small question mark will display under the cursor.  

Then, the user can click on any button to display OrgPublisher help related to the 

toolbar button selected.  

More information on the OrgPlan toolbar: 

What functions do the OrgPlan buttons and menu items offer?

Web Admin Chart Administrator Help
Chart administrators using Web Administration can go to the Help Menu and 

select the Help pointer option to display Help for any toolbar button selected.  In 

addition, the Getting Started Guide, User Manual, Quick Start Videos, and How to 

Guides in the Aquire Customer Care Center are available for additional guidance.

Figure 22. OrgPublisher OrgPlan Help

Figure 23. OrgPublisher Web Admin Help

http://www.aquire.com/resources/dyn/files/573160z1d659208/_fn/OP10OrganizationPlanning.pdf#view=fit&page=9
http://www.aquire.com/customers/support/training_videos_materials/orgpublisher_quick_start
http://www.aquire.com/customers/support/how_to
http://www.aquire.com/customers/support/how_to
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